Learning Objectives

After completing this chapter, you will be able to:
- Describe the nature of isometric and oblique views.
- Set an isometric grid.
- Construct isometric objects.
- Create isometric text styles.
- Demonstrate isometric and oblique dimensioning techniques.

Being able to visualize and draw three-dimensional shapes is a skill that every drafter, designer, and engineer should possess. This is especially important in 3D modeling. However, there is a distinct difference between drawing a view that looks three-dimensional and creating a true 3D model.

A 3D model can be rotated on the display screen to view from any angle. The computer calculates the points, lines, and surfaces of the objects in space. Three-dimensional models are introduced in Chapter 27. This chapter focuses on creating views that look three-dimensional, using some special AutoCAD functions and two-dimensional coordinates and objects.

PICTORIAL DRAWING OVERVIEW

The word pictorial means "like a picture." It refers to any realistic form of drawing. Pictorial drawings show height, width, and depth. Several forms of pictorial drawings are used in industry today. The least realistic is oblique. However, this is the simplest type. The most realistic, but also the most complex, is perspective. Isometric drawing falls midway between the two as far as realism and complexity are concerned.

Oblique Drawings

An oblique drawing shows objects with one or more parallel faces having true shape and size. A scale is selected for the orthographic, or front faces. Then, an angle for the depth (receding axis) is chosen. The three types of oblique drawings are cavalier, cabinet, and general. See Figure 26-1. These vary in the scale of the receding axis. The receding axis is drawn at half scale for a cabinet view and at full scale for a cavalier. The general oblique is normally drawn with a 3/4 scale for the receding axis.
Isometric Drawings

Isometric drawings are more realistic than oblique drawings. The entire object appears as if it is tilted toward the viewer. The word isometric means equal measure. This equal measure refers to the angle between the three axes (120°) after the object has been tilted. The tilt angle is 35°16'. This is shown in Figure 26-2. The 120° angle corresponds to an angle of 30° from horizontal.

NOTE
When constructing isometric drawings, remember that lines parallel in the orthogonal views must be parallel in the isometric view.

The most appealing aspect of isometric drawing is that all three axis lines can be measured using the same scale. This saves time, while still producing a pleasing pictorial representation of the object. This type of drawing is produced when you use Isometric Snap mode, discussed later.

Closely related to isometric drawing is dimetric and trimetric. These forms of pictorial drawing differ from isometric in the scales used to measure the three axes. Dimetric drawing uses two different scales, and trimetric uses three scales. Using different scales is an attempt to create foreshortening. This means the lengths of the sides appear to recede. The relationship between isometric, dimetric, and trimetric drawings is illustrated in Figure 26-3.
Perspective Drawing

The most realistic form of pictorial drawing is perspective. The eye naturally sees objects in perspective. Look down a long hall and notice that the wall and floor lines seem to converge in the distance at an imaginary point. That point is called the vanishing point. The most common types of perspective drawing are one-point and two-point. These forms of pictorial drawing are often used in architecture. They are also used in the automotive and aircraft industries. Examples of one-point and two-point perspectives are shown in Figure 26-4. A perspective of a 3D model can be produced in AutoCAD using the DVIEW and 3DORBIT commands. See AutoCAD and its Applications—Advanced for complete coverage of DVIEW and 3DORBIT.

Figure 26-4.
An example of one-point and two-point perspective.

One-point Perspective

Two-point Perspective

ISOMETRIC DRAWING

The most common method of pictorial drawing used in industry is isometric. These drawings provide a single view showing three sides that can be measured using the same scale. An isometric view has no perspective and may appear somewhat distorted. Isometric axes are drawn at 30° to horizontal. See Figure 26-5.

The three axes shown in Figure 26-5 represent the width, height, and depth of the object. Lines that appear horizontal in an orthographic view are placed at a 30° angle. Lines that are vertical in an orthographic view are placed vertically. These lines are parallel to the axes. Any line parallel to an axis can be measured and is called an isometric line. Lines not parallel to the axes cannot be measured and are called nonisometric lines. Note the two nonisometric lines in Figure 26-5.

Figure 26-5.
Isometric axes layout. Lines not parallel to any of the three axes are called nonisometric lines.
Circular features shown on isometric objects must be oriented properly or they appear distorted. The correct orientation of isometric circles on the three principle planes is shown in Figure 26-6. These circles appear as ellipses on the isometric object. The small diameter (minor axis) of the ellipse must always align on the axis of the circular feature. Notice that the centerline axes of the holes in Figure 26-6 are parallel to one of the isometric planes.

A basic rule to remember about isometric drawing is that lines parallel in an orthogonal view must be parallel in the isometric view. AutoCAD's ISOPLANE feature makes that task, and the positioning of ellipses, easy.

Figure 26-6. Proper isometric circle (ellipse) orientation on isometric planes. The minor axis always aligns with the axis centerline.

PROFESSIONAL TIP
If you are ever in doubt about the proper orientation of an ellipse in an isometric drawing, remember that the minor axis of the ellipse must always be aligned on the centerline axis of the circular feature. This is shown clearly in Figure 26-6.

Setting for Isometric Drawing

You can quickly set your isometric variables in the Drafting Settings dialog box. To access this dialog box, enter DS, SE, DSETTINGS, RM, or DDRMODES at the Command: prompt, or select Drafting Settings... from the Tools pull-down menu. This dialog box can also be accessed by right-clicking the Snap or Grid status bar button and then selecting Setting... from the shortcut menu. The Snap and Grid tab of this dialog box contains options for isometric drawing. See Figure 26-7.

To activate the isometric snap grid, pick the Isometric snap radio button in the Snap type & style area. Notice that the Grid X spacing and Snap X spacing edit boxes are grayed-out. Since X spacing relates to horizontal measurements, it is not used in the isometric mode. You can only set the Y spacing for grid and snap in isometric. Be sure to pick the Snap On (F9) and Grid On (F7) check boxes if you want Snap and Grid modes to be activated. Select the OK button and the grid dots on the screen change to the isometric orientation, as shown in Figure 26-8. If your grid dots are not visible, turn the grid on.

Notice the crosshairs also change and appear angled. This aids you in drawing lines at the proper angles. Try drawing a four-sided surface using the LINE command. Draw it so that it appears to be the left side of a box in an isometric layout. See Figure 26-9. To draw nonparallel surfaces, you can change the angle of the crosshairs to make your task easier.
Figure 26-7.
The **Drafting Settings** dialog box allows you to pick settings needed for isometric drawing.

Figure 26-8.
An example of an isometric grid setup in AutoCAD.

Grid dots align to isometric orientation
To turn off the Isometric mode, pick the **Rectangular snap** button in the **Snap type & style** area. The Isometric mode is turned off and you are returned to the drawing area when you pick the **OK** button.

**NOTE**

You can also set the Isometric Snap mode at the Command: prompt with the **SNAP** command. Type **SNAP** or **SN**, select the **Style** option, and then type 1 to select **Isometric**.

**Changing the isometric crosshairs orientation**

Drawing an isometric shape is possible without ever changing the angle of the crosshairs. However, the drawing process is easier and quicker if the angles of the crosshairs align with the isometric axes.

Whenever the isometric snap style is enabled, simply press the [F5] key or the [Ctrl]+[E] key combination and the crosshairs immediately change to the next plane. AutoCAD refers to the isometric positions as **isoplanes**. The isoplanes are displayed on the prompt line as a reference. The three crosshair orientations and their angular values are shown in Figure 26-10.

**Figure 26-10.**
The three isometric crosshair positions can be changed using the [F5] function key, the [Ctrl]+[E] key combination, or using the **ISOPLANE** command.

- **Left**: 90° and 150°
- **Top**: 30° and 150°
- **Right**: 90° and 30°
Another method to toggle the crosshair position is with the **ISOPLANE** command. Enter ISOPLANE at the Command: prompt as follows:

Command: **ISOPLANE**
Current isoplane: Right
Enter isometric plane setting [Left/Top/Right] <current>: R

Press [Enter] to toggle the crosshairs to the next position. The command line displays the new isoplane setting. You can toggle immediately to the next position by pressing [Enter] at the Command: prompt to repeat the ISOPLANE command and pressing [Enter] again. To specify the plane of orientation, type the first letter of that position.

The ISOPLANE command can also be used transparently while in another command to toggle between isoplanes. For example, suppose that you start to draw a line and then realize you are in the left isoplane and need to be in the top isoplane. The procedure to use is as follows:

Command: **LINE**
Specify first point: ‘ISOPLANE’
Current isoplane: Top
>>Enter isometric plane setting [Left/Top/Right] <current>: R
Current isoplane: Right
Resuming LINE command.
Specify first point: (continue with command)

**PROFESSIONAL TIP**
The quickest way to change the isoplane is to press the [F5] function key or press the [Ctrl]+[E] key combination.

The crosshairs are always in one of the isoplane positions when the isometric snap style is in effect. An exception occurs during a display or editing command when a multiple selection set method (such as a window) is used. In these cases, the crosshairs change to the normal vertical and horizontal positions. At the completion of the display or editing command, the crosshairs automatically revert to their former isoplane orientation.

**EXERCISE 26-1**

- Use one of your templates to begin a new drawing.
- Set the grid spacing at .5.
- Use the Drafting Settings dialog box to activate Isometric Snap mode. Specify .25 vertical spacing.
- Use the **LINE** command to draw the objects shown. Do not dimension the objects.
- Change the **ISOPLANE** orientation as needed.
- Save the drawing as EX26-1.
Isometric Ellipses

Placing an isometric ellipse on an object is made easy using AutoCAD. An ellipse is positioned automatically to the current isoplane setting. To use the ELLIPSE command, pick the Ellipse button on the Draw toolbar, select Axis, End from the Ellipse cascading menu in the Draw pull-down menu, or enter EL or ELLIPSE at the Command prompt. Once the ELLIPSE command is initiated, the following prompts appear:

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: \( \overrightarrow{L} \)
Specify center of isocircle: \( \text{pick a point} \)
Specify radius of isocircle or [Diameter]:

Do not select the Center option; this method does not allow you to create isocircles. Instead, select Isocircle, pick the center point, and then select the radius or diameter.

Always check the isoplane position before locating an ellipse on your drawing. You can dynamically view the three positions that an ellipse can take. Enter the ELLIPSE command, pick the Isocircle option, and press [F5] to toggle the crosshair orientation. See Figure 26-11. The ellipse rotates each time you toggle the crosshairs.

The isometric ellipse is a true ellipse. If selected, grips are displayed at the center and four quadrant points. This simplifies the editing process. See Figure 26-12.

Figure 26-11.
The orientation of an isometric ellipse is determined by the crosshair orientation.

PROFESSIONAL TIP
Prior to drawing isometric ellipses, it is good practice to first place a marker at the ellipse center point. A good technique is to draw a point using an easily visible point style at the center. This is especially useful if the ellipse does not fall on grid or snap points.

CAUTION
It may be tempting to resize or otherwise adjust an isometric ellipse or arc by selecting one of the grips. Keep in mind that as soon as you resize an isometric ellipse in this manner, its angular value has changed and it is no longer isometric. If you rotate an isometric ellipse while Ortho mode is on, it will not appear in a proper isometric plane. You can rotate an isometric ellipse, but be sure to enter a value of 120° if you want it to rotate from one of the isometric planes to another.
**EXERCISE 26-2**

- Open EX26-1 if this drawing is not already on your screen.
- Select the ELLIPSE command to place an ellipse on the three sides of the object.
- Draw the numbered ellipses in the following manner:
  - Pick a radius of .5 using the cursor to draw Ellipse 1.
  - Enter a radius of .75 at the keyboard to draw Ellipse 2.
  - Enter D and then a diameter of .6 at the keyboard to draw Ellipse 3.
- The finished drawing should look like the example given below.
- Save the drawing as EX26-2.

---

**Constructing Isometric Arcs**

The ELLIPSE command can also be used to draw an isometric arc of any included angle. To construct an isometric arc, use the Arc option of the ELLIPSE command. To access the Arc option, pick the Ellipse button on the Draw toolbar and then enter A, enter EL or ELLIPSE at the Command: prompt and then enter A, or select Arc from the Ellipse cascading menu in the Draw pull-down menu. Once the Arc option is initiated, the following prompts appear:

1. **Specify axis endpoint of elliptical arc or [Center/Isocircle]:**
2. **Specify center of isocircle: (pick the center of the arc)**
3. **Specify radius of isocircle or [Diameter]: (pick the radius or type a value and press [Enter])**
4. **Specify start angle or [Parameter] (pick a start angle or type a value and press [Enter])**
5. **Specify end angle or [Parameter/Included angle]: (pick an end angle or type an included angle value and press [Enter])**
6. **Command:**

A common application of isometric arcs is drawing fillets and rounds. Once a round is created isometrically, the edge (corner) of the object sits back from its original, unfilled position. See Figure 26-13A. You can draw the complete object first,
then trim away the excess after locating the fillets. You can also draw the isometric arcs and then the connecting lines. Either way, the center point of the ellipse is a critical feature, and should be located first. The arc at the upper left was drawn first, then copied to the upper back position using grips. Use Ortho mode to help quickly draw 90° arcs.

The next step is to move the original edge to its new position. This is tangent to the isometric arcs. You can do this by snapping the line to the quadrant point of the arc. See Figure 26-13B. Notice the grips on the line and on the arc. The endpoint of the line is snapped to the quadrant grip on the arc. The final step is to trim away the excess lines and upper right arc. The completed feature is shown in Figure 26-13C.

Rounded edges, when viewed straight on, cannot be shown as complete-edge lines that extend to the ends of the object. Instead, a good technique to use is a broken line in the original location of the edge. This is clearly shown in the figure in Exercise 26-3.

Figure 26-13.
Rounds can be drawn with the Arc option of the ELLIPSE command.

EXERCISE 26-3

☐ Load AutoCAD and begin a new drawing named EX26-3.
☐ Set the grid spacing at .5.
☐ Set the Isometric Snap mode and specify a .25 vertical spacing.
☐ Use the LINE command and draw the object shown below. Do not dimension the object.
☐ Fillets and rounds are all .25 radius.
☐ Change the isoplane as needed, and use the ELLIPSE command and Arc option to complete the object.
☐ Save the drawing as EX26-3.
Figure 26-12.
An isometric ellipse
has grips at its four
quadrant points and
its center.

EXERCISE 26-2
☐ Open EX26-1 if this drawing is not already on your screen.
☐ Select the ELLIPSE command to place an ellipse on the three sides of the object.
☐ Draw the numbered ellipses in the following manner:
  ☐ Pick a radius of .5 using the cursor to draw Ellipse 1.
  ☐ Enter a radius of .75 at the keyboard to draw Ellipse 2.
  ☐ Enter D and then a diameter of .6 at the keyboard to draw Ellipse 3.
☐ The finished drawing should look like the example given below.
☐ Save the drawing as EX26-2.

Constructing Isometric Arcs

The ELLIPSE command can also be used to draw an isometric arc of any included
angle. To construct an isometric arc, use the Arc option of the ELLIPSE command. To
access the Arc option, pick the Ellipse button on the Draw toolbar and then enter A,
enter EL or ELLIPSE at the Command: prompt and then enter A, or select Arc from the
Ellipse cascading menu in the Draw pull-down menu. Once the Arc option is initiated,
the following prompts appear:

Specify axis endpoint of elliptical arc or [Center/Isocircle]: I
Specify center of isocircle: (pick the center of the arc)
Specify radius of isocircle or [Diameter]: (pick the radius or type a value and press
[Enter])
Specify start angle or [Parameter] (pick a start angle or type a value and press
[Enter])
Specify end angle or [Parameter/Included angle]: (pick an end angle or type an
included angle value and press [Enter])
Command:

A common application of isometric arcs is drawing fillets and rounds. Once a
round is created isometrically, the edge (corner) of the object sits back from its origi-
nal, unfilleted position. See Figure 26-13A. You can draw the complete object first,
then trim away the excess after locating the fillets. You can also draw the isometric arcs and then the connecting lines. Either way, the center point of the ellipse is a critical feature, and should be located first. The arc at the upper left was drawn first, then copied to the upper back position using grips. Use Ortho mode to help quickly draw 90° arcs.

The next step is to move the original edge to its new position. This is tangent to the isometric arcs. You can do this by snapping the line to the quadrant point of the arc. See Figure 26-13B. Notice the grips on the line and on the arc. The endpoint of the line is snapped to the quadrant grip on the arc. The final step is to trim away the excess lines and upper right arc. The completed feature is shown in Figure 26-13C.

Rounded edges, when viewed straight on, cannot be shown as complete-edge lines that extend to the ends of the object. Instead, a good technique to use is a broken line in the original location of the edge. This is clearly shown in the figure in Exercise 26-3.

Figure 26-13.
Rounds can be drawn with the Arc option of the ELLIPSE command.

EXERCISE 26-3

☐ Load AutoCAD and begin a new drawing named EX26-3.
☐ Set the grid spacing at .5.
☐ Set the Isometric Snap mode and specify a .25 vertical spacing.
☐ Use the LINE command and draw the object shown below. Do not dimension the object.
☐ Fillets and rounds are all .25 radius.
☐ Change the isoplane as needed, and use the ELLIPSE command and Arc option to complete the object.
☐ Save the drawing as EX26-3.
Creating Isometric Text Styles

Isometric text should appear to lie in one of the isometric planes. Drafters and artists occasionally neglect this aspect of pictorial drawing and it shows on the final product. Text should align with the plane that it applies to. This involves creating new text styles.

Figure 26-14 illustrates possible orientation of text on an isometric drawing. Text may be located on the object or positioned away from it as a note. These examples were created using only two text styles. These text styles are based on styles that use an obliquing angle of either 30° or -30°. The labels refer to the style numbers given in the chart below. The angle indicates the rotation angle entered when using one of the TEXT commands. For example, ISO-2 90 means that the ISO-2 style was used and the text was rotated 90°. This technique can be applied to any font.

<table>
<thead>
<tr>
<th>Name</th>
<th>Font</th>
<th>Obliquing Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO-1</td>
<td>Romans</td>
<td>30°</td>
</tr>
<tr>
<td>ISO-2</td>
<td>Romans</td>
<td>-30°</td>
</tr>
</tbody>
</table>

**EXERCISE 26-4**

- Use one of your templates to begin a new drawing.
- Create one text style to label the angled (nonisometric) surface of the wedge. See the illustration below.
- Create a second style to label the front of the wedge.
- Save the drawing as EX26-4.
Creating Isometric Text Styles

Isometric text should appear to lie in one of the isometric planes. Drafters and artists occasionally neglect this aspect of pictorial drawing and it shows on the final product. Text should align with the plane that it applies to. This involves creating new text styles.

Figure 26-14 illustrates possible orientation of text on an isometric drawing. Text may be located on the object or positioned away from it as a note. These examples were created using only two text styles. These text styles are based on styles that use an obliquing angle of either 30° or -30°. The labels refer to the style numbers given in the chart below. The angle indicates the rotation angle entered when using one of the TEXT commands. For example, ISO-2 90 means that the ISO-2 style was used and the text was rotated 90°. This technique can be applied to any font.

<table>
<thead>
<tr>
<th>Name</th>
<th>Font</th>
<th>Obliquing Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO-1</td>
<td>Romans</td>
<td>30°</td>
</tr>
<tr>
<td>ISO-2</td>
<td>Romans</td>
<td>-30°</td>
</tr>
</tbody>
</table>

EXERCISE 26-4

☐ Use one of your templates to begin a new drawing.
☐ Create one text style to label the angled (nonisometric) surface of the wedge. See the illustration below.
☐ Create a second style to label the front of the wedge.
☐ Save the drawing as EX26-4.
Figure 26-17.
Creating isometric arrowheads. A—Draw the two isometric axes for arrowhead placement. B—Draw the first arrowhead on one of the axis lines. Then, mirror the arrowhead to create others.

Oblique Dimensioning

AutoCAD has a way to semiautomatically dimension isometric and oblique lines. First, the dimensions must be drawn using any of the linear dimensioning commands. Figure 26-18A illustrates an object dimensioned using the DIMALIGNED and DIMLINEAR commands. Then, use the DIMEDIT command’s Oblique option to rotate the extension lines. See Figure 26-18B.

To access the Oblique option, enter DED or DIMEDIT at the Command: prompt and then enter O for Oblique. You can also select Oblique from the Dimension pull-down menu. When prompted, select the dimension and enter the obliquing angle.

Figure 26-18A shows numbers by each dimension. The following list gives the obliquing angle required for each numbered dimension in order to achieve the finished drawing shown in Figure 26-18B.

Figure 26-18.
The OBLIQUE dimensioning command requires that you select an existing dimension and enter the desired obliquing angle. Refer to the text for the angles represented by the circled numbers.
<table>
<thead>
<tr>
<th>Dimension</th>
<th>Obliquing Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30°</td>
</tr>
<tr>
<td>2</td>
<td>-30°</td>
</tr>
<tr>
<td>3</td>
<td>30°</td>
</tr>
<tr>
<td>4</td>
<td>-30°</td>
</tr>
<tr>
<td>5</td>
<td>30°</td>
</tr>
</tbody>
</table>

This technique creates suitable dimensions for an isometric drawing and is quicker than the previous method discussed. Keep in mind that the oblique method does not rotate the arrows so that the arrowhead heels are aligned with the extension lines. It also does not draw the dimension text aligned in the plane of the dimension.

**Chapter Test**

Write your answers in the spaces provided.

1. The simplest form of pictorial drawing is _____.
2. How does isometric drawing differ from oblique drawing?
3. How do dimetric and trimetric drawings differ from isometric drawings?
4. The most realistic form of pictorial drawing is _____.
5. What values must be set in the **Drafting Settings** dialog box to set Isometric Snap mode with a spacing of 0.2?
6. What function does the **ISOPLANE** command perform?
7. Which pull-down menu contains the command to access the **Drafting Settings** dialog box?
8. What factor determines the orientation of an isometric ellipse?
9. Name the command and option used to draw an isometric ellipse.
10. Which text style setting allows you to create text that can be used on an isometric drawing?
11. What command and two options must you select in order to draw isometric arcs?
12. On what parts of an isometric circle are grips located?
13. Can grips be used to correctly resize an isometric circle? Explain your answer.
14. What technique does AutoCAD provide for dimensioning isometric objects?

**Drawing Problems**

Create an isometric template drawing. Use the template to construct the isometric drawings in Problems 1–10. Items that should be set in the template include grid spacing, snap spacing, ortho setting, and text size. Save the template as **isoprotodw**. Save the drawing problems as **P26-(problem number)**.

1. 

2. 

---

AutoCAD and its Applications—Basics
Oblique Dimensioning

AutoCAD has a way to semiautomatically dimension isometric and oblique lines. First, the dimensions must be drawn using any of the linear dimensioning commands. Figure 26-18A illustrates an object dimensioned using the DIMALIGNED and DIMLINEAR commands. Then, use the DIMEDIT command's Oblique option to rotate the extension lines. See Figure 26-18B.

To access the Oblique option, enter DED or DIMEDIT at the Command: prompt and then enter O for Oblique. You can also select Oblique from the Dimension pull-down menu. When prompted, select the dimension and enter the obliquing angle.

Figure 26-18A shows numbers by each dimension. The following list gives the obliquing angle required for each numbered dimension in order to achieve the finished drawing shown in Figure 26-18B.
<table>
<thead>
<tr>
<th>Dimension</th>
<th>Obliquing Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30°</td>
</tr>
<tr>
<td>2</td>
<td>-30°</td>
</tr>
<tr>
<td>3</td>
<td>30°</td>
</tr>
<tr>
<td>4</td>
<td>-30°</td>
</tr>
<tr>
<td>5</td>
<td>30°</td>
</tr>
</tbody>
</table>

This technique creates suitable dimensions for an isometric drawing and is quicker than the previous method discussed. Keep in mind that the oblique method does not rotate the arrows so that the arrowhead heels are aligned with the extension lines. It also does not draw the dimension text aligned in the plane of the dimension.

**Chapter Test**

Write your answers in the spaces provided.

1. The simplest form of pictorial drawing is ____.  
2. How does isometric drawing differ from oblique drawing?  
3. How do dimetric and trimetric drawings differ from isometric drawings?  
4. The most realistic form of pictorial drawing is ____.  
5. What values must be set in the *Drafting Settings* dialog box to set Isometric Snap mode with a spacing of 0.22?  
6. What function does the *ISOPLANE* command perform?  
7. Which pull-down menu contains the command to access the *Drafting Settings* dialog box?  
8. What factor determines the orientation of an isometric ellipse?  
9. Name the command and option used to draw an isometric ellipse.  
10. Which text style setting allows you to create text that can be used on an isometric drawing?  
11. What command and two options must you select in order to draw isometric arcs?  
12. On what parts of an isometric circle are grips located?  
13. Can grips be used to correctly resize an isometric circle? Explain your answer.  
14. What technique does AutoCAD provide for dimensioning isometric objects?

**Drawing Problems**

Create an isometric template drawing. Use the template to construct the isometric drawings in Problems 1–10. Items that should be set in the template include grid spacing, snap spacing, ortho setting, and text size. Save the template as *isoprint.dwt*. Save the drawing problems as P26-(problem number).

1. ![Image 1]

2. ![Image 2]
For Problems 11–14, create isometric drawings using the views shown.
15. Construct a set of isometric arrowheads to use when dimensioning isometric drawings. Load your isometric template drawing. Create arrowheads for each of the three isometric planes. Save each arrowhead as a block. Name them with the first letter indicating the plane: T for top, L for left, and R for right. Also number them clockwise from the top. See the example for the right isometric plane. Save the template again when finished.

16. Create a set of isometric text styles like those shown in Figure 26-14. Load your template drawing and make a complete set in one font. Make additional sets in other fonts if you wish. Enter a text height of 0 so that you can specify the height when placing the text. Save the template again when finished.

17. Begin a new drawing named P26-17 using your template. Select one of the following problems to dimension: Problem 5, 7, 8, or 9. When adding dimensions, be sure to use the proper arrowhead and text style for the plane that you are working in. Save the drawing when completed.

18. Create an isometric drawing of the switch plate. Select a view that displays the features of the object. Do not include dimensions. Save the drawing as P26-18.
19. Create an isometric drawing of the retainer. Select a view that displays the features of the object. Do not include dimensions. Save the drawing as P26-19.